
  
    
  
Initial Setup



To set up GnuCash to handle accounts receivable for a company two
    preliminary things must be done. The first is to build an appropriate
    Account Hierarchy and the second is to register the company in
    GnuCash.
Account Setup



There are many different ways to set up a business account
      hierarchy. You can start with the Business Accounts setup which is
      available from the New Account Hierarchy assistant, or you could build one
      manually. To access the prebuilt Business Accounts, start GnuCash and
      click on File → New File and
      proceed until you see the list of available accounts, select Business
      Accounts.
The prebuilt Business Account hierarchy will not meet your needs
      exactly. You will need make adjustments for the hierarchy to function
      well with your particular situation. It should be close enough that it
      is recommended you begin with it.
Accounts Receivable (or A/R) refers to products or services
      provided by the company on credit for which payment has not yet been
      received. This is represented on the balance sheet as an asset, because
      you expect to receive payment soon. To use GnuCash’s integrated accounts
      receivable system, you must first set up an account (usually a
      sub-account under Assets) defined with account type
      A/Receivable. It is within this account that the
      integrated A/R system will place transactions.


Basic A/R Account Hierarchy:



-Assets

   -Checking

   -Accounts Receivable

-Income

   -Sales

  

You need to add additional asset, expense, and income accounts to
      this hierarchy for it to be useful. The important aspects of this
      hierarchy are the use of an income account and the Accounts Receivable
      asset account, with account type set to
      A/Receivable.
Note
You do not need to create an individual A/R account for each
        customer. GnuCash keeps track of customers internally and provides
        per-customer reports based on the internal tracking.


Company Registration



After you have built the account structure, register the GnuCash
      file as belonging to your company. To register your company, select
      File → Properties:
	Enter the name of your company along with contact information
          such as your phone number, fax number, e-mail address and website
          URL.

	Enter your company’s tax payer id number in the
          Company ID field.

	Select default tax tables applicable to your most common
          customers and vendors.





Accounting



Q: How do I treat taxes?  As an account payable or as an expense?



A: This is a loaded question, and you should really talk to your accountant.  How you treat taxes really depends on what kind of taxes they are, and how you WANT to treat them..  In some cases they are expenses, in some cases they are liabilities.


Chapter 8. Investments



This chapter explains how to manage your investments with GnuCash.
  Most people have an investment plan, whether its just putting money into a
  CD account, investing through a company sponsored plan at your workplace or
  buying and selling stocks and bonds through a brokerage. GnuCash gives you
  tools to help you manage these investments such as the Price
  Editor  which allows you to record changes in the prices of
  stocks you own.
Basic Concepts



An investment is something that you purchase in the hopes of
    generating income, or that you hope to sell in the future for more than
    you paid. Using this simple definition, many things could be considered
    investments: the house you live in, a valuable painting, stocks in
    publicly traded companies, your savings account at the bank, or a
    certificate of deposit. These many types of investments will be discussed
    in this chapter in terms of how to track them using GnuCash.
Terminology



Before discussing investments specifically, it will be helpful to
      present a glossary of investment terminology. The terms presented below
      represent some of the basic concepts of investing. It is a good idea to
      become familiar with these terms, or at least, refer back to this list
      if you encounter an unfamiliar word in the later sections.
	Capital gains is the difference between
          the purchase and selling prices of an investment. If the selling
          price is lower than the purchase price, this is called a
          capital loss. Also known as realized
          gain/loss.

	Commission is the fee you pay to a broker
          to buy or sell securities.

	Common stock is a security that
          represents a certain fractional ownership of a company. This is what
          you buy when you “buy stock” in a company on the open market. This
          is also sometimes known as capital
          stock.

	Compounding is the concept that the
          reinvested interest can later earn interest of its own (interest on
          interest). This is often referred to as compound
          interest.

	Dividends are cash payments a company
          makes to shareholders. The amount of this payment is usually
          determined as some amount of the profits of the company. Note that
          not all common stocks give dividends.

	Equities are investments in which the
          investor becomes part (or whole) owner in something. This includes
          common stock in a company, or real estate.

	Interest is what a borrower pays a lender
          for the use of their money. Normally, this is expressed in terms of
          a percentage of the principal per year. For example, a savings
          account with 1% interest (you are the lender, the bank is the
          borrower) will pay you $1 for every $100 you keep there per
          year.

	Liquidity is a measure of how easily
          convertible an investment is to cash. Money in a savings account is
          very liquid, while money invested in a house has low liquidity
          because it takes time to sell a house.

	Principal is the original amount of money
          invested or borrowed.

	Realized vs Unrealized Gain/Loss,
          unrealized gain or loss occurs when you’ve got a change in price of
          an asset. You realize the gain/loss when you actually sell the
          asset. See also capital gain/loss.

	Return is the total income plus capital
          gains or losses of an investment. See also
          Yield.

	Risk is the probability that the return
          on investment is different from what was expected. Investments are
          often grouped on a scale from low risk (savings account, government
          bonds) to high risk (common stock, junk bonds). As a general rule of
          thumb, the higher the risk the higher the possible return.

	Shareholder is a person who holds common
          stock in a company.

	Stock split occurs when a company offers
          to issue some additional multiple of shares for each existing stock.
          For example, a “2 for 1” stock split means that if you own 100
          shares of a stock, you will receive an additional 100 at no cost to
          you. The unit price of the shares will be adjusted so there is no
          net change in the value, so in this example the price per share will
          be halved.

	Valuation is the process of determining
          the market value or the price the investment would sell at in a
          “reasonable time frame”.

	Yield is a measure of the amount of money
          you earn from an investment (IE: how much income you receive from
          the investment). Typically this is reported as a percentage of the
          principal amount. Yield does not include capital gains or loses (see
          Return). Eg: A stock sells for $100 and gives $2 in dividends per
          year has a yield of 2%.




Types of Investments



Below is presented some of the broad types of investments
      available, and examples of each type.
	Interest-bearing account or
          instrument
This type of investment usually allows you immediate access to
          your money, and will typically pay you interest every month based on
          the amount of money you have deposited. Examples are bank savings
          accounts (and some interest bearing checking accounts) and cash
          accounts at your brokerage. This is a very low risk investment, in
          the US these accounts are often insured against loss, to a specified
          limit.
Sometimes an interest bearing investment is
          time-locked. This type of investment requires
          you to commit your money to be invested for a given period of time
          for which you receive a set rate of return. Usually, the longer you
          commit the higher the interest rates. If you withdraw your money
          before the maturity date, you will usually have to pay an early
          withdrawal penalty. This is a relatively lower risk investment.
          Examples are certificates of deposit or some government bonds. Other
          types of Bonds may have higher yields based on the higher risks from
          the quality of the issuer’s “credit rating”.

	Stocks and Mutual Funds
This is an investment you make in a company, in which you
          effectively become a part owner. There is usually no time lock on
          publicly traded stock, however there may be changes in the tax rates
          you pay on capital gains depending on how long you hold the stock.
          Thus, stocks are typically quite liquid, you can access your money
          relatively quickly. This investment is a higher risk, as you have no
          guarantee on the future price of a stock.
A mutual fund is a group investment mechanism in which you can
          buy into many stocks simultaneously. For example, a "S&P 500
          index fund" is a fund which purchases all 500 stocks listed in the
          Standard and Poor’s index. When you buy a share of this fund, you
          are really buying a small amount of each of the 500 stocks contained
          within the fund. Mutual funds are treated exactly like a single
          stock, both for tax purposes and in accounting.

	Fixed Assets
Assets that increase in value over time are another form of
          investment. Examples include a house, a plot of land, or a valuable
          painting. This type of investment is very difficult to determine the
          value of until you sell it. The tax implications of selling these
          items is varied, depending on the item. For example, you may have
          tax relief from selling a house if it is your primary residence, but
          may would not receive this tax break on an expensive
          painting.
Fixed asset investments are discussed in Chapter 9, Capital Gains and 
          Chapter 11, Depreciation. Typically, there is not much to do
          in terms of accounting for fixed asset investments except recording
          the buying and selling transactions.






Setting Up Accounts



When a borrower obtains a loan, it is usually with the intention to
    make a purchase of something of value. In fact, most loans require the
    borrower to buy some predetermined asset, such as a house. This asset is
    insurance against the borrower defaulting on the loan. There are, of
    course, examples of loans which do not necessarily have an associated high
    value asset, such as educational loans.
For the account structure presented here, we will assume the loan
    was used to purchase a compensating asset.
A loan is a liability, the interest you accrue on the loan is an
    on-going expense, and any administrative fees you may have to pay would be
    another expense. The thing purchased with the money from a loan is an
    asset. With these parameters, we can now present a basic loan account
    structure:


Basic Loan Account Structure



-Asset

    -Current Assets

        -Savings Account

    -Fixed Assets

        -Asset Purchased

-Liability

   -Loans

       -Mortgage Loan

-Expenses

   -Interest

       -Mortgage Interest

   -Mortgage Adm Fees

  

GnuCash has a number of predefined loan account hierarchies
    available, including Car Loans and Home Mortgage Loans. To access these
    predefined account structures, click on 
    Actions → New Account Hierarchy... and select the loan types in which you are interested.

Appendix D. Auxiliary File Formats



These are the formats of some auxiliary files used by GnuCash.
Check Format Files (*.chk)



Overview



The check format file is used to tell GnuCash how to print a check or checks onto a page of paper.  This file first describes the overall layout of a page (number of checks, orientation, etc) and then describes the layout of the specific items on a single check.  The file is organized as a typical Key/Value file used by many Linux applications.  Keys/values pairs are grouped into sections that begin with the group name enclosed in square brackets.
GnuCash looks for check format files in two different locations when you bring up the check printing dialog.  The first location is typically /usr/share/gnucash/checks, where check files distributed with the application can be found.  The second location is the user private ~/.gnucash/checks directory.  Users may add check formats at any time (even while GnuCash is running) simply by dropping a new *.chk file in this directory.  The next time the check printing dialog is opened the new check format will appear in the list of available check formats.
Note
Printing functions differently depending on the version of GTK that is installed on your system.  When GnuCash is using a version of GTK prior to 2.10 all offsets are measured from the lower left corner of the page or check.  When using GTK 2.10 or later, all offsets are measured from the upper left corner of the page or check.


Example file



A typical GnuCash check file is presented below.  The contents of this file will be described in the next sections.

[Top]
Guid = 67b144d1-96a5-48d5-9337-0e1083bbf229
Title = Quicken/QuickBooks (tm) US-Letter
Rotation = 0.0
Translation = 0.0;4.0
Show_Grid = false
Show_Boxes = false

[Check Positions]
Height = 252.0
Names = Top;Middle;Bottom

[Check Items]
Type_1 = PAYEE
Coords_1 = 90.0;102.0;400.0;20.0

Type_2 = AMOUNT_WORDS
Coords_2 = 90.0;132.0

Type_3 = AMOUNT_NUMBER
Blocking_Chars_3 = true
Coords_3 = 500.0;102.0

Type_4 = DATE
Coords_4 = 500.0;67.0

Type_5 = NOTES
Coords_5 = 50.0;212.0
        

Field Descriptions



Top Group



This section of the check file describes the overall layout of a page of checks (or check) that goes into the printer.
Table D.1. Overall Page Description Fields
	Name	Type	Required	Description
	Guid	string	mandatory	The guid is used to uniquely identify a check format to GnuCash.  It must be unique across the entire set of application supplied and user supplied check formats.  If you copy an application check file as the basis of your own check format, you must change this value.  The uuidgen program may be used to generate these identifiers.
	Title	string	mandatory	The title is used to uniquely identify a check format to the user.  This value is presented verbatim in the check format list of the check printing dialog.  If you copy an application check file as the basis of your own check format, you should change this value.  The title may be any utf-8 string.
	Font	string	optional	If supplied, this is the default font used to print all text items on this check.  This field can contain any string that is acceptable by gtk as a font specifier.  If this field is omitted, the default font is the font specified in the GnuCash preferences dialog.  A typical string would be “sans 12”.
	Blocking_Chars	boolean	optional	If supplied, this is the default used when printing all TEXT items on this check.  When set to true, will print *** before and after each text field on the check.  Blocking characters are printed to protect check fields from alteration.  For example, the amount field may be printed as ***100.00***
	DateFormat	boolean	optional	If supplied, this is the default used when printing all DATE items on this check.  When set to true, will print the format of the DATE in 8 point type, centered and below the actual DATE.  For example DDMMYYYY.
	Rotation	double	optional	This value specified the rotation of the entire page (in degrees) around the origin point. For gtk versions prior to 2.10, the origin point is in the lower left corner of the page and rotation values increase in the counter-clockwise direction.  For gtk version 2.10 and later, the origin point is in the upper left corner of the page and rotation values increase in the clockwise direction. Rotation of the page is applied before translation.
	Translation	list of 2 doubles	optional	These values specify the x and y translation of the entire page (in points) relative to the origin point. For gtk versions prior to 2.10, the origin point is in the lower left corner of the page and translation values increase moving up and to the right.  For gtk version 2.10 and later, the origin point is in the upper left corner of the page and translation values increase moving down and to the right. Rotation of the page is applied before translation.
	Show_Grid	boolean	optional	If this value is set to true then GnuCash will draw a grid on the page, starting at the origin with the lines spaced every 50 points. This can be helpful when creating a check format file.
	Show_Boxes	boolean	optional	If this value is set to true then for each item where the width and height have been specified, GnuCash will draw a box showing location and maximum size of that item . This can be helpful when creating a check format file.




Note
The Blocking_Chars and DateFormat options are defined for all check formats in Edit->Preferences->Printing.  It is recommened that these global options be set to false (the default), and that the options be set for individual Check Items as described below.


Check Positions Group



This group of items specifies how multiple checks are laid out on the same sheet of paper, and gives names to each of these check locations so that a user can specify which check location that GnuCash should print.  This entire group of key/value pairs is optional, and should be omitted if the format file only specifies a single check per page of paper.
Table D.2. Multiple Checks Per Page Fields
	Name	Type	Required	Description
	Height	double	mandatory	This field specifies the height of a single check on the page.  If there are multiple checks per page then this item is mandatory.  If there is only a single check per page, this entire section should be omitted.
	Names	list of strings	mandatory	This field specifies the names of the check locations that can be printed on each page.  These names represent the check positions starting from the top of the page and moving downward.  The names are presented verbatim in the check position list of the check printing dialog.  A typical value for this field is "Top;Middle;Bottom", but it could also be "First;Second;Third" or any other set of strings that clearly identify the check locations.  If there are multiple checks per page then this item is mandatory.  If there is only a single check per page, this entire section should be omitted.





Check Items Group



This section specifies the individual items that are printed on the check.  There is no limit to the number of items that may be present in this section, and any given type of item can be repeated multiple times.  This allows for the printing of checks that have a side stub, or for the one-per-page business checks that have both the check and multiple check stubs on the same page.  For example, to print the payee name on a business check and on both stubs, simply specify three payee items with differing print coordinates.
Each key names in this section explicitly includes the item number to which it applies.  E.G. The key named Type_1 applies to the first item to be printed, and the key Coords_3 applies to the third item to be printed.  Item numbers start at one and increase sequentially.  Any gap in the numbering sequence is interpreted by GnuCash as the end of the item list.  Items are printed in the order of their item numbers, not in the order in which they appear in the file.
Each item specified must include a type declaration.  The rest of the parameters for that item depend upon the particular type of that item.  See Table D.4, “Individual Check Item Types” for a list of valid item types and their required parameters.
Table D.3. Individual Check Item Fields
	Name	Type	Required	Description
	Type_n	string	mandatory	This field specifies the type of a single item to be printed on a check.  See Table D.4, “Individual Check Item Types” for a list of valid item types.
	Coords_n	list of 2 or 4 doubles	mandatory	This field specifies the coordinates where the item should be placed on a check, and optionally also specifies the width and height of the item.  The numbers in order are the X and Y offset of the lower left corner of the item, and optionally the width and height of the item.  If the width is supplied then the height must also be supplied, so this field will always contain two or four numbers.  For gtk versions prior to 2.10, the origin point is in the lower left corner of the page and translation values increase moving up and to the right.  For gtk version 2.10 and later, the origin point is in the upper left corner of the page and translation values increase moving down and to the right.Note
Regardless of whether the origin is at the top or the bottom of the page, the coordinates always specify the lower left point of the item.


	Font_n	string	optional	If supplied, this is the font used to print this specific text item.  This field can contain any string that is acceptable by gtk as a font specifier.  If this field is omitted, the default font is the font specified in the Top section of the check description file, or if that was omitted the font specified in the GnuCash preferences dialog.  This field is only recognized when using gtk version 2.10 or later.
	Align_n	string	optional	If supplied, this is the alignment used to print this specific text item.  This field must contain one of the strings “left”, “center” or “right”.  If this field is omitted, the text will be left aligned.  This field is only recognized when using gtk version 2.10 or later.
	Text_n	string	optional	This field is only used when the item type is TEXT. It specifies the utf-8 text that should be printed on the check.
	Filename_n	string	optional	This field is only used when the item type is PICTURE. It specifies the filename of the image that should be printed on the check.  The string may specify either an absolute path name or as a relative path name.  If a relative path name is specified, GnuCash first looks in in the application check format folder (typically /usr/share/gnucash/checks) for the image file, and if it isn’t found there then it looks in the user private ~/.gnucash/checks directory for the image.  This field is only recognized when using gtk version 2.10 or later.
	Blocking_Chars_n	boolean	optional	If supplied, this will set the print Blocking_Chars option for this item.
	DateFormat_n	boolean	optional	If supplied, this will set the print DateFormat option for this item.




These are the individual items that can be printed on a check.  All items require the coordinates on the page where the item should be printed.  The majority of these items result in text being printed on the page, and these items may have individual font and alignments specified.  For example, the numerical amount of a check could be printed right justified while everything else is printed left justified.  Other types may have unique parameters.
Table D.4. Individual Check Item Types
	Name	Required Fields	Optional Fields	Description
	PAYEE	Coords	
                    Font

Align

Blocking_Chars

                    


                  	This type value tells GnuCash to print the check payee name at the specified coordinates.
	DATE	Coords	
                    Font

Align

Blocking_Chars

DateFormat

                    


                  	This type value tells GnuCash to print the check date at the specified coordinates.
	NOTES	Coords	
                    Font

Align

Blocking_Chars

                    


                  	This type value tells GnuCash to print the transaction notes field at the specified coordinates.
	CHECK_NUMBER	Coords	
                    Font

Align

Blocking_Chars

                    


                  	This type value tells GnuCash to print the check number at the specified coordinates.
	MEMO	Coords	
                    Font

Align

Blocking_Chars

                    


                  	This type value tells GnuCash to print the split memo field at the specified coordinates.
	ACTION	Coords	
                    Font

Align

Blocking_Chars

                    


                  	This type value tells GnuCash to print the split action field at the specified coordinates.
	AMOUNT_WORDS	Coords	
                    Font

Align

Blocking_Chars

                    


                  	This type value tells GnuCash to print the check amount in words at the specified coordinates.  The amount will appear similar to the string "One thousand, two hundred thirty four and 56/100".
	AMOUNT_NUMBER	Coords	
                    Font

Align

Blocking_Chars

                    


                  	This type value tells GnuCash to print the check amount in numbers at the specified coordinates.  The amount will appear similar to the number "$1,234.56".
	ADDRESS	Coords	
                    Font

Align

Blocking_Chars

                    


                  	This type value tells GnuCash to print the address at the specified coordinates.
	SPLITS_ACCOUNT	Coords	
                    Font

Align

Blocking_Chars

                    


                  	This type value tells GnuCash to print the account names for each split entry stating at the specified coordinates. See the note on splits printing.
	SPLITS_AMOUNT	Coords	
                    Font

Align

Blocking_Chars

                    


                  	This type value tells GnuCash to print the amount for each split entry stating at the specified coordinates.  Amounts are printed with currency symbols. See the note on splits printing.
	SPLITS_MEMO	Coords	
                    Font

Align

Blocking_Chars

                    


                  	This type value tells GnuCash to print the memo text for each split entry stating at the specified coordinates. See the note on splits printing.
	TEXT	Coords, Text	
                    Font

Align

Blocking_Chars

                    


                  	This type value tells GnuCash to print an arbitrary string at the specified coordinates. The string to be printed is specified with the Text_n key.
	PICTURE	Coords, Filename	(none)	This type value tells GnuCash to print an image at the specified coordinates. The image to be printed is specified with the Filename_n key.  This type is only recognized when using gtk version 2.10 or later.




Note
SPLIT items include all split entries for the transaction except for the split that applies to the current account register.  This is usually the last split listed when splits are displayed in the register.  The coordinate location defines the lower left location for the split information.



Creating Check Format Files



Creating your own check format file is a fairly simple task.  The easiest way to start is to copy an existing check format file from the application directory (typically /usr/share/gnucash/checks) to the directory ~/.gnucash/checks.  Make sure to change the guid so the new file will be accepted by gnucash, and change the title to something descriptive.  Then change or add individual item fields as necessary.  You can also create a new check file by clicking the Save Format button on the Custom format page of the check printing dialog.
Note
Key names are case sensitive.  If you’re having problems with a check format file, ensure that all key names have capital letters as documented above.




Account Setup



As with most accounting practices, there are a number of different
    ways to setup capital gains accounts. We will present here a general
    method which should be flexible enough to handle most situations. The
    first account you will need is an Asset Cost account
    (GnuCash account type Asset), which is simply a place where you record
    the original purchase of the asset. Usually this purchase is accomplished
    by a transaction from your bank account.
In order to keep track of the appreciation of the asset, you will
    need three accounts. The first is an Unrealized Gains
    asset account in which to collect the sum of all of the appreciation
    amounts. The Unrealized Gains asset account is balanced by a
    Unrealized Gains income account, in which all
    periodic appreciation income is recorded. Finally, another income account
    is necessary, called a Realized Gains in which you
    record the actual capital gains upon selling the asset.
Below is a generic account hierarchy for tracking the appreciation
    of 2 assets, ITEM1 and ITEM2. The Assets:Fixed Assets:ITEM1:Cost accounts are
    balanced by the Assets:Current Assets:Savings Account account, 
    the Assets:Fixed Assets:ITEM1:Unrealized Gains
    accounts are balanced by the Income:Unrealized Gains account (similar for ITEM2).


-Assets

    -Current Assets

        -Savings Account

    -Fixed Assets

        -ITEM1 

            -Cost

            -Unrealized Gain

        -ITEM2

            -Cost

            -Unrealized Gain

-Income

    -Realized Gains

    -Unrealized Gains

  


Chapter 16. Other Assets



General Concepts



This chapter presents many additional accounting treatments for
    frequently encountered business and less-frequently found personal activities
    that need recording in accounting books. The explanations below cover both the
    description and purpose of the activity, and they include also the usual
    accounting treatments (bookings or recordings) for these transactions.
These concepts have evolved over centuries of experience by those
    keeping accounting records and will help you maximize your record keeping’s
    utility and meaningfulness.
This section introduces categorization of assets in the balance sheet
    based on time or the asset’s useful life (current and long-term). Sometimes
    assets are also considered from the standpoint of their liquidity
    , which is regarded as how close or distant the asset is from
    being turned into cash. Near-cash assets are relatively quickly converted
    to cash (e.g., accounts receivable), while assets requiring rather a long
    time to convert to cash are considered to be relatively fixed
     in their non-cash state (e.g., heavy equipment, buildings, land).
    (Fixed does not mean they were repaired!)
You should find that current assets parallel those with more liquidity,
     while long-term and fixed assets are those with much less liquidity. Finally,
     below you will find a few assets that could be either current or long-term
     based on the nature of the facts constituting them.


Data Entry Concepts



When entering data in GnuCash, you should be aware of the 3 levels
    of organization in which GnuCash divides your data: files, accounts and
    transactions. These levels are presented in their order of complexity, one
    file contains many accounts and one account contains many transactions.
    This division is fundamental to understanding how to use GnuCash.
Files



GnuCash stores information at the
      highest level in files. A file can be stored on your computer either
      as a single XML file (in all versions of
      GnuCash), or in a SQL
      database (in GnuCash version 2.4 and higher).
Note
SQL is pronounced “sequel”,
        so in spoken and written language we would say “a SQL
        database”.

With the XML file format,
      GnuCash stores your data in an
      XML data file, usually in compressed format
      (although this can be changed in the General
      tab of the GnuCash Preferences).
With SQL storage,
      GnuCash stores your data in a
      SQL database under the database application you
      select (SQLite3, MySQL or PostgreSQL).
You will need one main file or database for each set of
      accounts you are maintaining. To learn how to create and manage
      GnuCash files, see the section called “Storing your financial data”.
Note
If you think you might need more than one set of accounts,
        you might want to consult a professional accountant or bookkeeper
        before proceeding. Most users will probably have only one data
        file.

Backup files and log files are automatically generated by
      GnuCash when appropriate. Backup and log
      files are described in the section called “Backing Up and Recovering Data”.

Accounts



An account keeps track of what you own,
      owe, spend or receive. Each GnuCash file can
      contain any number of accounts, and each account can contain many
      sub-accounts up to an arbitrary number of levels. This simple feature
      gives GnuCash much of its power in managing
      your finances, as you will see in later chapters.
Examples of accounts include: checking accounts, savings
      accounts, credit card accounts, mortgages, and loans. Each
      GnuCash account tracks the activity for that
      “real” account, and can inform you of its status.
In addition, accounts are also used to categorize the money you
      receive or spend. For example, you can create expense accounts to
      track the money you pay on utilities or groceries. Even though these
      are not accounts that receive statements, they allow you to determine
      how much money is being spent in each of these areas.
Accounts will be covered in more detail in Chapter 3, Accounts.

Transactions



A transaction represents the movement of
      money among accounts. Whenever you spend or receive money, or
      transfer money between accounts, that is a transaction.
Examples of transactions are: paying a phone bill, transferring
      money from savings to checking, buying a pizza, withdrawing money,
      and depositing a paycheck. Chapter 4, Transactions goes more
      in depth on how to enter transactions.
In double entry accounting, transactions always involve at
      least two accounts–a source account and a destination account.
      GnuCash manages this by inserting a line
      into the transaction for every account that is affected, and
      recording the amounts involved in each line. A line within a
      transaction that records the account and amount of money involved is
      called a split. A transaction can contain an
      arbitrary number of splits.
Splits in transactions will be covered in the section called “Split Transaction”


Choosing a Register Style



GnuCash offers several options for viewing your registers. The
    default style is Basic Ledger mode, which displays
    only the summary of splits affecting the current account. This is the
    style that most closely resembles other popular personal financial
    packages.
You can choose a different register style by selecting
    View → Auto-Split Ledger
    style expands the current transaction automatically. As you highlight a
    new transaction in the register, the transaction automatically expands to
    show all splits. The View → Transaction
    Journal style is more like an accounting journal, in which
    all splits are shown for all transactions.
All styles permit you to view your data in either single-line or
    double-line format. Select View → Double Line, and you will see your transaction
    line expand to two register lines.
Let’s have a closer look at how the Basic Ledger and Transaction Journal view differs.
    
For this example, let’s assume that you have a checking account with $10,000,
    and have decided to really splurge by purchasing 3 pair of Jeans for $1,000.
    Now, you can either record this as one simple transaction and move $1,000 to Expenses:Clothes.
    Or, you can record a split transaction, and record each Jeans individually.
Technically they are the same, but from an accounting point of view, when you 
    record each Jeans purchase separately, the Expenses:Clothes account will record three
    different transactions.
The below screenshots will illustrate this a bit better
First let’s purchase the Jeans from your checking account
[image: 3 Jeans purchases]
            This image shows one split transaction with 3 Jeans purchases
          



The we open the Expenses:Clothes account, and look at it from the default Basic Ledger view.
     As you can see, we have three entries here, but there were only one entry in the checking account.
     If you look carefully, you will see that each row have a different amount, $200, $300, and $500.
     Each row’s transaction line reflects a one split row.
[image: A jump to the Expenses:Clothes account]This image shows Expenses:Clothes account
          in Basic Ledger mode.



If we view the Expenses:Clothes account in Transaction Journal mode, you will again, only see
      the original split transaction.
[image: A jump to the Expenses:Clothes account]This image shows Expenses:Clothes account in
          Transaction Journal mode.




Vendor Jobs



Vendor Jobs are used to group multiple bills from a single vendor.  Use of the vendor jobs feature is optional.  The feature is useful when you have multiple jobs for the same vendor, and would like to view all the bills for a single job.
To use vendor jobs, you must create them using the Business → Vendor → New Job application.  You will see the New Job window.  The editable fields are:
	Job Info - Job Number (optional) - enter
        the number for this job. If left blank, a number will be chosen for
        you.

	Job Info - Job Name - the name you want to
        assign to the new job.

	Owner Info - Vendor - the vendor for
        whom the job is created.

	Owner Info - Billing ID - the vendor’s
        reference to this job (e.g. their PO Number).

	Job Active - toggles this job being active
        or not. This is useful when you have many inactive jobs, since it is
        easier to search only among jobs that are marked active.



[image: New Vendor Job]New Vendor Job



To edit an existing vendor job, use the Business → Vendor → Find Job application. Select the desired job in the
    search results, and click the View/Edit Job
    button.
To select from the bills associated with a given job, use Business → Vendor → Find Job application. Select the desired job in the
    search results and click the View Invoices button. A
    window listing bills associated with this job appears. Select a
    bill and click the View Invoice button to open a
    bill editor in the main application window.

8. TRANSLATION




      Translation is considered a kind of modification, so you may
      distribute translations of the Document under the terms of section 4. Replacing  Invariant Sections with
      translations requires special permission from their copyright
      holders, but you may include translations of some or all
      Invariant Sections in addition to the original versions of these
      Invariant Sections. You may include a translation of this
      License provided that you also include the original English
      version of this License. In case of a disagreement between the
      translation and the original English version of this License,
      the original English version will prevail.
    

Creating a Budget



Even before you begin to make a budget, it’s important to
   have given some thought to your account hierarchy.  For example, if
   you want to budget a certain amount for your electric bill and a
   certain amount for your water bill, you can’t have only an
   Expenses:Utilities account.  Your accounts must be at least as
   specific as your budget.  
Choose Which Accounts To Budget For



The first step in creating a budget is to decide what it is
     you want to plan for.  This decision will affect which accounts
     you include in your budget.  For example, if you are only
     interested in tracking your expenses, you may create an expense
     budget by only entering amounts for expense accounts.  On the
     other hand, if you want to track all of your cash flow, you may
     create a cash flow budget by entering amounts for asset,
     liability, income and expense accounts.
Before you begin to create your budget, you need to make
     two decisions: What accounts do I want to budget for?  and When
     do I want my budget to be for?  You can always change your mind
     later, after you’ve created a budget, but you need to start with
     something.
Tip
As a rule of thumb, if you mostly care about
     what you spend your money on, you may want
     to make an expense report.  If you’re also concerned about having
     enough money in the right places at the right times, you may want
     to use a cash-flow budget.


Choosing a Budget Period



Before creating a budget you must also decide what period of
    time you want to plan for.  The most common budget periods are
    monthly and annual.  If you want your budget to plan for changes
    in financial patterns over time, then you should include multiple
    budget periods in your budget.  For example, if you want to plan
    on having higher utility expenses in the winter than in the
    summer, then you might break your annual budget into 4 quarters or
    even 12 months, and budget a higher value for the winter periods
    than for the summer periods.

Getting Started



To create your first budget click on Actions → Budget → New Budget.  You will
    immediately see a new budget with the default settings and no entries.
    Then click on the Options button.  The most important options are
    the budget period and the number of periods.  For the budget period,
    choose the beginning date and the smallest period of time that you
    want to plan for.  Then, for the number of periods, choose how many
    periods you want to plan for.
The budget page now shows a list of accounts with a column
    for each budget period.  The date shown in the title of each
    column is the beginning of that budget period.

Entering Budget Values



Now, you must enter the budget values - the amounts that you
    expect the account balances to change during the budget period.
    There are two ways to enter budget values.  The first way is to
    simply click on the cell and enter an amount.
If you have past transactions recorded in GnuCash, the
    second way is to let GnuCash estimate the budget values by looking
    at those transactions.  First, select the accounts you want
    GnuCash to estimate.  Then click on the Estimate Toolbar button.
    In the Estimate Budget Values dialog, select the date past which
    GnuCash should look for past transactions.  GnuCash will start at
    that date and look forward for the duration of your budget.  For
    example, if you are making an annual budget, and you select
    Jan. 1, 2005, GnuCash will look at all the transactions in that
    account from Jan. 1, 2005 through Dec. 31, 2005.


Current Assets



This section explains short-term receivables, reimbursable expenses,
          travel advances, prepaid premiums, prepaid rent, suspense or wash accounts.
          
Short-term Receivables



This kind of account
          is useful to reflect an agreement made with someone you trust.
          Suppose you lent someone $500 and he agreed to repay you $50 a month.
          If he paid on time, the loan you made would be paid off within a year,
          which is why it is classified as a short-term receivable. So you
          could record that loan initially in this account tree: OtherAssets:Current Assets:LoanToJoe.
          At the time you give him the money: your
          entry is debit (increase) LoanToJoe $500 and credit (decrease) Bank
          $500. Each time you receive Joe’s payment you record $50 debit
          (increase) to Bank and credit (decrease) LoanToJoe.
Tip
Don’t become confused by the use of the word “Loan”.
          “Loan-To” is the tipoff that you really have a receivable, that is,
          you will receive from Joe, the money you previously loaned. Until he
          actually pays the money owed you, you reflect his debt in your books
          by an account describing your expectation–you will receive the
          money owed you, hence the word “receivable”.


Reimbursable Expenses



This kind of activity
          is one in which you spend your own money on behalf of someone else
          (your employer, perhaps) and later you receive repayment of what you
          spent. The case might be a business trip. The employer has a policy
          of covering (paying for) all authorized expenses. After the
          trip is over, the employee submits a report listing dates and amounts
          spent with receipts for all the expenditures. The employer reviews
          the report and pays for all items that it considers as having a valid business reason.
          (Normally, employees know in advance what the employer will
          reimburse, so only those items are recorded as a reimbursable expense
          on the employee’s books.)
Because a business trip can involve different kinds of expenditures
          (air travel, lodging, transportation at the destination, etc.),
          different kinds of expenditures would be recorded in the one account
          as long as the expenditures all related to the same trip. In other
          words, if a second trip is made before the first is fully settled, a
          second account for a different event could be set up. It would make
          sense to do this, if it would help to keep separate all the details of
          one trip from those of another. It is up to the person making the
          trip to decide how much trouble it would be to put separate trips in
          separate accounts or to put them all in the same account. The trip
          taker should remember that the account must be reconciled in order to
          know with certainty that all expenses have been reimbursed.
Recording the expenditures on the trip would be much the same.
          That is, if you paid trip expenses by cash you would debit (increase) the
          reimburseable expense account for the money paid in cash, because it
          is a receivable to you until it has been reimbursed to you. The credit
          offsetting your expenditure would decrease the account that shows the
          cash in your pocket or the account from which you drew the cash for
          the payment made. If you paid by credit card, the debit side would be
          the same as just described, but the credit would be an increase to the
          credit card company account on your books.
When you received your reimbursement, then the journal entry (or
          transaction) to record receipt of the funds from the employer would be:
          debit (increase) Bank for the check amount and credit (decrease) the
          reimbursable expense account for the check amount.
If it turns out that the reimbursable expense account is not
          zero balance after processing the employer’s payment, then it means that
          there is a difference between you and the employer in handling the expense,
          which needs to be investigated. If the balance is a debit
          (a positive balance), your account has some money that was not reimbursed.
          If the balance is a credit (a negative balance), you were paid for more
          than what you recorded as due you. In both of those situations you should
          reconcile the difference between what you recorded and what was paid.
          That effort should disclose exactly what is causing the discrepancy.
          You will need to contact the employer’s bookkeeper to know what was paid,
          if the reimbursement check was not accompanied by a detailed list of the
          items being paid you.
In the event the employer refused to reimburse you for an
          expenditure, that effectively makes it your expense. In that case, you
          would make this entry: debit (increase) your own Expense
          (appropriately named) and credit (decrease) the Reimbursable Expense
          account. That entry should result in a zero balance in the
          Reimbursable Expense account. If not, reconcile until you identify
          the difference.
Tip
Sometimes there are small differences that don’t match an
          individual entry. In those cases divide the amount by 2 or by 9. If
          the unresolved amount is divisible by two, it suggests that both you
          and the employer entered the item in the same manner: both as debits
          or both as credits. If it is divisible by 9, then likely one of you
          transposed adjoining numbers; e.g., one entered 69 and the other
          entered 96. If the difference is divisible neither by 2 or by 9, then
          it could be that more than one error is present.


Travel Advances



These are very similar to
          Reimbursable Expenses. The difference is that someone gives you
          money first; you spend it, and then you give a report accounting for
          what you spent it on. The report is supported by invoices establishing
          who, what, where, when, and how much for each expenditure. In the
          Reimbursable Expense case, you spent your money first and later
          recovered it.
In the Travel Advance case when you receive the advance, you
          record on your books this entry: debit (increase) Bank for the travel
          advance amount received (say, $500); credit (increase) the short-term
          liability Travel Advance ($500). This is a liability, because
          you are not gifted with the money, but only loaned it for the purpose
          of having funds to spend when doing the employer’s business.
Frequently, the way these monetary arrangements work is that at
          the beginning of for example a salesperson’s employment, he or she receives the advance
          and monthly (or more frequently) turns in a report about who, what,
          where, when, and how much he spent. The money in the report is
          reimbursed if approved.
          
During the period after receiving the advance and before filing
          a request for reimbursement report, the salesperson can record his or her expenditures into
          the advance liability account. In that case, the balance
          in the account will show how much of the advance has not yet been spent
          (assuming the Travel Advance balance is a credit). If no mistakes have
          been made and all expenses are approved, then the sum of the unspent
          account balance and the reimbursing check amount will equal the original
          travel advance amount.
It makes sense for the salesperson to record the travel expenses to this advance account (and
          not to his or her own expense accounts), because the money is being spent
          on behalf of the employer, for the employer’s authorized expenses. It
          is not the employee’s own money, and therefore not his or her own expense.
          
When the salesperson receives the report reimbursement (say, $350), he or she debits
          (increases) Bank, and credits (increases) again the Travel Advance
          liability account, assuming that previously he or she had been recording
          expenditures to the travel advance account. Tracking activity in this
          manner causes the account to always show the amount that is owed the
          employer.
See the section called “Reimbursable Expenses” above for what to do if
          the employer does not accept an item the employee put on the travel
          advance reimbursement request report. The difference resolution effort
          is essentially the same for both types of accounts.

Prepaid Premiums or Prepaid Rent



Some types of
          expenses are usually billed as semi-annual or annual amounts. For
          example, the insurance industry will bill home insurance annually,
          while car insurance premiums can be annual or semi-annual. For those
          that pay an amount that covers several months or a full year, the
          proper accounting treatment is to reflect in each accounting period
          the amount that expresses the benefit applying to that period.
In the case of someone who pays a full-year’s insurance premium
          at the beginning of the insurance period, the entry to record this is
          debit (increase) Prepaid Insurance Premium for say, $1,200, and credit
          (decrease) Bank for $1,200.
Then a monthly recurring journal entry (scheduled transaction)
          is created that debits (increases) Insurance Expense $100 and credits
          (decreases) Prepaid Insurance Premium $100. This technique spreads
          the cost over the periods that receive the insurance coverage benefit.
          Businesses following generally accepted accounting practices would
          normally use this technique, especially if they had to present
          financial statements to banks or other lenders. Whether individuals do
          depends on the person and how concerned they are to match cost with
          benefit across time periods. Another factor influencing use of this
          technique would be the number of such situations the person encounters.
          It is relatively easy to remember one or two, but more difficult if
          having to manage 10 to 20. You would set up as many or as few as proved
          useful and important to you.

Suspense or Wash Accounts



The purpose of
          these accounts is to provide a device to track “change of mind” situations.
          The objective of these accounts is to provide a temporary location to
          record charges and credits that are not to be included permanently in
          your books of record. When the transactions reflected in these accounts
          have been fully completed, Wash/Suspense accounts will normally carry
          a zero balance.
For example, say in the grocery store you see canned vegetables on sale,
          so you buy 6 cans at $1 per can. Say that the total purchases were $50.
          When you come home and are putting things in the cupboard you discover
          you already had 12 cans. You decide to return the 6 you just bought.
          Some persons in this situation would charge (increase) the whole bill
          to Grocery Expense; and when they returned the cans, they would credit
          (decrease) Grocery Expense. That is one way of handling that. The effect
          of this method is to leave recorded on your books the cost of items that
          you really did not purchase from a permanent standpoint. It is only
          when the items have actually been returned and the vendor’s return
          receipt has also been recorded that the distortion this method generates
          will then be removed.
Actually, there are several treatments, depending on when and how
         the original transaction was booked/recorded and when you decided to
         return the items purchased. Basically, did you change your mind before
         you recorded the transaction or after doing so?
If you decided to return the items after recording the purchase
         transaction, you may originally have charged Grocery Expense for the full
         amount ($50) of all items. In that scenario, what you kept and the amount of
         the items to be returned were grouped into one account. You could edit the
         original transaction and restate the amount charged to the Grocery Expense
         account to be the difference ($44) between the total paid ($50) for groceries
         and the value of the items to be returned. That leaves the returned-item
         value as the amount ($6) you should record to the Suspense account.
Obviously, if you decided to return items before you recorded your
         purchase, then you would book the original entry as a charge to Grocery
         Expense for the amount kept ($44) and as a charge to Suspense for the
         amount returned ($6). The off-setting credit ($50) to cash or credit
         card is not affected by these treatments.
When there are several persons shopping and at different vendors,
         there can be a case where there are several returns happening at once
         and in overlapping time frames. In that case the Wash Account is
         charged (increased) at time of changing the mind, and either Bank or
         Credit Card is credited. When the return occurs, the reverse happens:
         Bank or Credit Card is debited for the cash value of the returned items
         and the Wash/Suspense Account is credited in the same amount.
If the wash account has a non-zero balance, scanning the debit
         and credit entries in the account will show the non-matched items.
         That is, debits not matched by offsetting credits indicate items
         intended to be returned but not actually returned yet. The reverse
         (credits not matched by offsetting debits) indicates that returns were
         made but the original charge was not recorded in the Wash Account.
These differences can be cleared up by returning unreturned items
         or recording charges (debits) for items already returned. The mechanics
         of doing that likely will be finding the original expense account the
         item was charged to and making an entry like: debit Wash Account, credit
         original expense. It also could be as described above where the original
         recording is adjusted by adding a charge to Wash/Suspense account and
         decreasing the amount charged to the original account.


Organization of QIF Files (Discussion)




  

Backing Up and Recovering Data



GnuCash creates several types of files to help ensure that your data
    is not lost. If you look in the folder where your saved .gnucash file resides, you may see other
    files generated by GnuCash with the following extensions: .gnucash,
    .log, .LCK, .LNK in the same directory 
    as your primary data file. What each of these files does is presented below.
Note
The following sections are relevant only if you are saving your financial data in the XML format


      $ ls 
      myfile.gnucash
      myfile.gnucash.20100414185747.gnucash
      myfile.gnucash.20100414223248.log
      myfile.gnucash.20100415114340.gnucash
      myfile.gnucash.20100415154508.log
      myfile.gnucash.20100415173322.gnucash
      myfile.gnucash.20100415194251.log
      myfile.gnucash.7f0982.12093.LNK
      myfile.gnucash.LCK
    
Backup file (.gnucash)



Each time you save your data file, a backup copy will also be
      saved with the extension .YYYYMMDDHHMMSS.gnucash. This backup file is a complete copy of
      your previous data file, and the filename format refers to the data
      file, year, month, day and time of the backup. For example, the filename
      myfile.gnucash.20100414185747.gnucash indicates this is a
      backup copy of the file myfile saved in the year 
      2010, April 14, at 6:57:47 p.m.
To restore an old backup file, simply open the .YYYYMMDDHHMMSS.gnucash file with the
      date to which you wish to return. Be sure to save this file under a
      different name.
Note
GnuCash versions 2.3.15 and older create backup files with the old extension
         .YYYYMMDDHHMMSS.xac instead of the actual extension .YYYYMMDDHHMMSS.gnucash. 
         So if you upgrade from the 2.2 series to the 2.4 series, you may end up with both .YYYYMMDDHHMMSS.xac 
         and .YYYYMMDDHHMMSS.gnucash backup files in your directory.


Log file (.log)



Each time you open a file in GnuCash, a .log file is created and saved
      with the same name format as the .YYYYMMDDHHMMSS.gnucash backup files. As you make changes
      to the open data file, the log file saves only those changes. Log files
      are not a full backup of your data file - they simply record changes you
      have made to the data file in the current GnuCash session.
In case you exit GnuCash inadvertently, possibly due to a power
      outage or a system wide crash, it is possible to recover most of your
      work since the last time you saved your GnuCash file using this log
      file. This is the procedure:
	Open the last saved GnuCash file.

	Go to File → Import → Replay GnuCash .log file
          and select the one .log file with the same date as the saved file
          you just opened. Make sure that you picked the right .log file, or
          you will possibly wreak havoc in your accounts.



Log replaying will recover any transaction affecting the balance
      entered since the last save, including those created from scheduled
      transactions and business features (invoices, bills, etc.).
Warning
Changes to the scheduled transactions, invoices or
        bills themselves are NOT recovered, and their transactions that were
        recovered may not be properly associated with them, and should thus be
        double-checked. Especially for business transactions, you may have to
        delete and re-create some of them. If you do not, although the balance
        will be correct, some reports may not.


Lock files (.LNK and .LCK)



You may occasionally see .LNK and .LCK files appear. These do not
      store any data, but they are created to prevent more than one user from
      opening the same file at the same time. These files are automatically
      created when you open the file, to lock it so no one else can access it.
      When you close your GnuCash session or open another file, GnuCash
      unlocks the first data file by deleting the .LCK and .LNK files.
If GnuCash crashes while you have a data file open, the .LCK and
      .LNK files are not deleted. The next time you try to open GnuCash, you
      will get a warning message that the file is locked. The warning message
      appears because the .LNK and .LCK files are still in your directory. It is
      safe to choose Yes to open the file, but you should delete the .LNK and
      .LCK files (using a terminal window or your file manager). Once those
      files are deleted, you will not get the warning message again unless
      GnuCash crashes.

File Management



So which files should you keep around? Keep your main data file,
      of course. It’s a
      good idea to keep some of the more recent .YYYYMMDDHHMMSS.gnucash backup files, but you can safely
      delete the .log files since they are not complete copies of your data.
Note
If you upgraded from a GnuCash version prior to 2.4, you may also have backup files
        in the old .xac format. For these files you can apply the same principle described above for
        .YYYYMMDDHHMMSS.gnucash backup files.

You should also delete any .LCK and .LNK files that you see after
      closing GnuCash. If you decide to back up your data file to another
      disk manually, it’s enough to back up the main data file - not the .YYYYMMDDHHMMSS.gnucash
      backup files.
Note
By default GnuCash will automatically delete any .log and .YYYYMMDDHHMMSS.gnucash
        backup files that are older than 30 days. You can change this behavior in the GnuCash
        preferences in the General tab under Edit → Preferences
        (Gnucash → Preferences on Mac OS X).



Top Ten Reasons to Use GnuCash



We’ve already discussed some of the general advantages of using
    GnuCash. Here are some specific features offered by GnuCash that may not
    exist in other programs.
	Simple user interface
GnuCash is as easy to use as a checkbook register. It’s simpler
        than a paper register, because auto-completion and other entry
        shortcuts not only do work for you, but reduce data entry
        errors.

	Easy import
GnuCash allows you to import data from on-line bank statements
        and software packages using QIF (Quicken® Interchange Format), OFX and
        HBCI files. An easy-to-use “assistant” walks you through
        reviewing resulting changes and actually importing them into
        GnuCash.

	Statement reconciliation
Reconcile monthly statements quickly by entering the statement
        ending balance and checking off transactions. GnuCash helps you catch
        any discrepancies between your data and statements you receive.

	Investment tracking
GnuCash offers a host of ways to track your investment
        portfolio. Special investment accounts simplify data entry, and
        on-line tools allow you to update prices of your holdings as the
        markets change. Reports complete the picture, allowing you to analyze
        your investment decisions.

	Multiple currency support
GnuCash allows you to track multiple currencies. If you have
        bank accounts, investments or other financial data in different
        currencies, use GnuCash to monitor them.

	Customized reports and graphs
Reports and graphs give you valuable information for filing
        taxes, budgeting, or simply figuring out where your money goes.
        GnuCash offers a variety of easy-to-use reports and graphs to help
        analyze your financial position. It gives you the freedom to customize
        your own reports to suit your unique needs.

	Double entry
To provide complete records, GnuCash uses the double entry
        method of bookkeeping. Double entry simply means that money doesn’t
        just appear or disappear - an equal amount must come from one location
        and go to another location. By tracking the transaction in both
        locations, GnuCash will give you detailed reports from the perspective
        of either account.

	Sources of help
A Tip of the Day screen gives helpful tips to new users about
        GnuCash features. Within the program, a searchable Help menu guides
        you to information or connects to the GnuCash web page for further
        assistance. GnuCash also has strong, helpful developer and user
        communities who provide help through mailing lists as well as through 
        the IRC channel.

	Shortcuts
GnuCash offers many shortcuts to help you enter data. Type the
        first few characters of a common entry and GnuCash will automatically
        fill in the rest! You can also use copy, paste and duplicate functions
        to save typing time. Keyboard shortcuts let you quickly choose a menu
        option or to enter numerical data. Many numeric entry fields can act
        as a calculator: enter "92.18+33.26" and watch GnuCash input the
        corresponding sum for you!

	Open source
GnuCash doesn’t hide its methods. If you wonder how GnuCash
        computed a number, you can find it out. In addition, you can set
        preferences that tell GnuCash how much information to display to you.
        There is no “secret code” used in GnuCash - it continues
        to be an open-source program.



These are only a few of the advantages you’ll discover when you
    start using GnuCash to track your financial information. Now get ready to
    enjoy the benefits of GnuCash for yourself!

Setting Up Accounts



To begin managing your credit cards in GnuCash, you should set up a
    Liability top level account and under this parent account create credit
    card type accounts for each credit card you use. If you are tracking only
    the payments you make to the credit card company, then all you need is a
    bank account and a credit card account to enter your transactions.
The charges you make on your credit card are expenses, so you will
    have to set up these accounts under the top-level account called
    Expenses. If you decide to keep a more detailed records of your
    purchases, you will need to create expense accounts for each kind of
    purchase you make. Since you will also be reconciling the balance to your
    credit card statements, you should also enter an opening balance in each
    credit card account. The easiest way to do this is to use your last
    statement balance as the opening balance.
Simple Setup



If you do not want to track each expense made on the credit card,
      you can set up a simple account hierarchy like this:


-Assets

   -Bank

-Liabilities

   -Credit Card

-Expenses

   -Credit Card

   

In this example, if you enter your total amount charged per month
      as a transaction between Liabilities:Credit Card and
      Expenses:Credit Card. When you make a payment, you would
      enter a transaction between Assets:Bank and
      Liabilities:Credit Card.
The obvious limitation of this simple credit card setup is that
      you cannot see where your money is going. All your credit card expenses
      are being entered in the Credit Card expense account. This is, however,
      very simple to set up and maintain.

Complete Setup



If you want to track your expenses more completely, you should
      set up multiple expense accounts named for the various kinds of expenses
      you have. Each charge on your credit card is then entered as a separate
      transaction between your Credit Card liability account and a specific
      expense account. Below is an example of an account hierarchy for
      this:


-Assets

    -Bank

-Liabilities

    -Credit Card

-Expenses

    -Food

    -Car

    -Clothes

    -Entertainment

    -Interest

    -Service

   

Clearly, you should enter specific expense accounts which fit your
      spending habits. The only difference with this setup as compared to the
      simple setup is that the expenses have been subdivided by groups. Also
      notice that there is an “Interest” expense, this is used for when your
      credit card charges interest on your monthly unpaid balance. The
      “Service” expense account is used to track service expenses associated
      with the credit card, such as the yearly usage fee if it exists. With
      this setup, you will be able to see where your money goes every month,
      grouped according to the expense accounts.
The rest of this chapter will assume you are using the complete
      setup.


6. COLLECTIONS OF DOCUMENTS




      You may make a collection consisting of the Document and other documents
      released under this License, and replace the individual copies
      of this License in the various documents with a single copy that
      is included in the collection, provided that you follow the
      rules of this License for verbatim copying of each of the
      documents in all other respects.
    

      You may extract a single document from such a collection, and
      dispbibute it individually under this License, provided you
      insert a copy of this License into the extracted document, and
      follow this License in all other respects regarding verbatim
      copying of that document.
    

Splits and Mergers



Companies may split their stock for many reasons but the most common
    is that the price has risen higher than management thinks is a reasonable price for
    many investors. Some of these splits are simple exchanges (eg 2 for 1 or 3 for 2)
    and some are complex exchanges with cash distributions.  Splits may also result in
    fewer shares if the exchange rate is a reverse split (1 for 3 or .75 for 1).

    
Simple Stock Split



As an example, our holding of NST stock declared a 2 for 1 stock split effective
      June 6, 2005.  The process for entering this transaction is; select 
      Actions → Stock Split to start
      the assistant.
[image: An image of the stock split assistant at step 1.]An image of the selection of the stock split assistant. 



The first screen is an Introduction, select Forward to
      display the selection of the account and stock for the split.  You will need to
      create an entry for each Account:Stock combination you hold.
[image: An image of the stock split assistant at step 2 - Selection of Account/Stock.]An image of the stock split assistant at step 2 - Selection of
           Account/Stock.



Select the Assets:Investments:DRIPs:NST and click on
      Forward.
The next screen presents 5 fields in the Stock Splits Details window:
	Date - Enter the date of the split.

	Shares -  The number of shares increased (or decreased)
          in the transaction.
In our example it is a 2 for 1 split so the number of additional shares
          is the number of shares currently in the register.

	Description - The Description should give a brief
          explanation of the transaction.

	New Price - If desired the new price of the stock,
          after the split, may be entered.

	Currency - The currency of the transaction
          is required.  This should be the same as the stock purchase currency.



Click on the Forward button.
[image: An image of the stock split assistant at step 3 - Split Details.]An image of the stock split assistant at step 3 - Split Details. 



The next screen will be skipped in this example as there was no
      “Cash in Lieu”.
      
[image: An image of the stock split assistant at step 4 - Cash in Lieu.]An image of the stock split assistant at step 4 - Cash in Lieu. 



A final Finish screen will give a last option to;
       Cancel, Back to modify any data entered or
       Apply to complete the stock split with the data entered. 
[image: Example of simple stock split transaction in the stock’s register]An image of the Assets:Investments:DRIPs:NST
          register after a simple stock split transaction. 




Moderately Complex Stock Merger



As an example, assume you held AT&T stock during the Nov. 18, 2005 merger of SBC
      with AT&T. For this example you will have purchased AT&T on April 1, 2005, any
      dividends will have been paid in cash, therefore not entered into the AT&T
      stock register. 
 The conditions of the merger were .77942 share of SBC stock were exchanged for
      each share of AT&T stock.  The merged company continued to use the symbol
      “T” from AT&T.
AT&T paid a “dividend” of $1.20/share on the transaction date,
      however this will not appear in the stock account as it was a cash distribution.
The process for entering this transaction is identical to the simple split until
      the “Details” screen.  You will need to create an split entry in each
      Investment Account:Stock account combination that has shares
      splitting.
[image: An image of the stock split assistant at step 2.]An image of the stock split assistant at step 2 - Selection of
           Account/Stock (Investment Account:T).



Select the Assets:Investments:Brokerage Account:Stock:T and click on
      Forward.
The next screen presents 5 fields in the Stock Splits Details window:
	Date - Enter the date of the split.  Here we’ll enter
           November 18, 2005.

	Shares -  The number of shares increased (or decreased)
          in the transaction.
In our example it is a .77942 for 1 split so the number of shares will
          decrease from the number of shares currently in the register.  You may use GnuCash’s
          ability to preform calculations on an entry form by entering data directly
          (E.g. “(.77942*100)-100”) to calculate the decrease in shares
          from the split.

	Description - The Description should give a brief
          explanation of the transaction.

	New Price - If desired the new price of the stock,
          after the split, may be entered.

	Currency - The currency of the transaction
          is required.  This should be the same as the stock purchase currency.



Click on the Forward button.
[image: An image of the stock split assistant at step 3.]An image of the stock split assistant at step 3 - Split Details. 



The next screen will be skipped in this example as there was no
      “Cash in Lieu”.
      
A final “Finish” screen will give a last option to
      Back to modify any data entered or Apply
      to complete the stock split with the data entered. 
[image: Example of moderate stock split transaction in the stock’s register]An image of the Investment Account:T register after a
           stock split transaction that decreases the shares. 





5. COMBINING DOCUMENTS




      You may combine the Document
      with other documents released under this License, under the
      terms defined in section 4
      above for modified versions, provided that you include in the
      combination all of the Invariant
      Sections of all of the original documents, unmodified,
      and list them all as Invariant Sections of your combined work in
      its license notice.
    

      The combined work need only contain one copy of this License,
      and multiple identical Invariant
      Sections may be replaced with a single copy. If there are
      multiple Invariant Sections with the same name but different
      contents, make the title of each such section unique by adding
      at the end of it, in parentheses, the name of the original
      author or publisher of that section if known, or else a unique
      number. Make the same adjustment to the section titles in the
      list of Invariant Sections in the license notice of the combined
      work.
    

      In the combination, you must combine any sections entitled
      “History” in the various original documents,
      forming one section entitled “History”; likewise
      combine any sections entitled “Acknowledgements”,
      and any sections entitled “Dedications”.  You must
      delete all sections entitled “Endorsements.”
    

Process Payment



Eventually, you need to pay your bills.  To do so, use the Process Payment application found in Business → Vendor → Process Payment.
The Process Payment application consists of:
	Payment Information - Vendor - the vendor you wish to pay. If you remember the company name
  you entered in the New Vendor window for this vendor,
  start to type it in this field and GnuCash will try auto complete 
  it for you. Else, press the Select... button to access the Find
  Vendor window described in the section called “Find and Edit”. Highlight the vendor you are looking for with a click 
  in the search results, then press the Select button.

	Payment Information - Bill - the bill you wish to pay. If you remember the bill ID,
  start to type it in this field and GnuCash will try auto complete 
  it for you. Else, press the Select... button to access the Find
  Bill window described in the section called “Find”. Highlight the bill you are looking for with a click 
  in the search results, then press the Select button in the search window.

	Payment Information - Date - the date you wish to make the payment, normally the current date.

	Payment Information - Amount - the amount of money to transfer in this payment.

	Payment Information - Num - the check number.

	Payment Information - Memo - any comments about this payment.

	Post To - the A/Payable account to post this transaction.

	Transfer Account - the account from which money for the payments comes from, such as a checking account.



Below is the GnuCash Accounts Receivable payment window.
[image: Process Payment]Process Payment Window
	       




Account Setup



Your default account currency is set in the Account tab 
    under Edit → Preferences
    (GnuCash → Preferences on Mac OS X).
    You should set this parameter correctly, as it will save you much time when building
    your account structure.
Similarly, GnuCash offers an option to
    set your preferred currency for displaying reports (like the balance
    sheet and income statement). The option is called Default
    Report Currency, and is in the Reports
    tab of the GnuCash Preferences screen.
    You’ll want to set both options when you start using
    GnuCash because if (for example) your accounts
    are all in Canadian Dollars but the generated reports are all in US
    Dollars, the reports will just say that there is “no
    data/transactions (or only zeroes) for the selected time
    period”.
When you create a new account, you have the option to define the
    commodity. For currency accounts, you can specify any one of the hundreds
    of currencies supported by GnuCash by simply selecting it from the
    currency commodity list. You will notice that the default currency is
    always whatever you have defined in the preferences. So, if you mostly
    work with Euros, but have the occasional Ethiopian Birr account, be sure
    to set your preferences to Euro.
As an example, let’s set up a typical bank account scenario where
    you mostly work in US Dollars, but do also have a European bank account
    using the Euro currency, as well as one bank account in Hong Kong using
    Hong Kong Dollars. So, setup 3 bank accounts, one using the Euro currency,
    one in US Dollars, and another in Hong Kong Dollars. One possible account
    structure for this would be:


-Assets                          (USD)

   -Current Assets           (USD)

      -US Bank                 (USD)

      -European Bank       (EUR)

      -HK Bank             (HKD)

-Equity                          (USD)

   -Opening Balances

      -USD            (USD)

      -EUR            (EUR)   

      -EUR            (HKD)



Note: the currency of each account is shown in parenthesis.

 

Since in this example you mostly work in USD, all of the parent
    accounts are set to USD. Of course, if you mostly work in Euros, you could
    change the currency of these parent accounts to EUR. To totals shown in
    the account tree window will always be converted to the currency of each
    particular account. Notice, we also setup 3 Starting Balances equity
    accounts, used to initially populate the 3 banks.
Note
You could also setup just a single Starting Balance account and
      use a currency transfer to populate the “different currency” accounts.
      However, this is more advanced option, which is explained in a later
      section (the section called “Purchase of an asset with foreign currency”.

Below you see the result of this example, in which you start with
    USD 10,000, EUR 10,000 as well as HKD 10,000 in the three bank accounts.
    Notice that the total of the parent accounts only show the value of the
    currency of sub-accounts with matching currencies. In the future you can
    setup the exchange rates between the currencies, and the parent accounts
    will calculate the converted value of all sub-accounts. See the later
    section (the section called “Recording/Updating Currency Exchange (How-To)”) on how to do this.
[image: Initial multi currency Account Bank Setup]Initial setup of 3 bank accounts with different
        currencies. 



Notice that the "Total (Report)" column is being displayed. This is
    configured in the column header row, select Arrow
    down and select “Total(USD)”.
User-Defined Currencies



Usually when we talk about currencies, we mean
      government-backed currencies (or more precisely, currencies defined
      in the international standard called ISO 4217).
      GnuCash does not allow you to create your
      own currencies. If you want to track non-ISO
      currencies, you can use either of two workarounds, depending on which
      fits your needs better.
Let’s say for example that you want to track RewardMiles,
      which count how many loyalty points you’ve earned by buying
      from a certain group of businesses. The account which tracks your
      RewardMiles will be Assets:Other:LoyaltyGroupRewardMiles.
The first method is to define a new security, of type FUND,
      called RewardMiles. This is pretty straightforward–when you
      create the new LoyaltyGroupRewardMiles account, just set the account
      type to Stock or Mutual
      Fund, click the Select... button
      next to the Security/currency: box, and click
      New to define a new security of type
      FUND.
This is not really what the stock and mutual fund account types
      are meant for, but GnuCash usually lets you
      decide how you want to use it, instead of dictating. The downside is
      that you’ll have to enter a “price” for every
      transaction involving RewardMiles, because
      GnuCash needs the prices to figure out the
      monetary value of RewardMiles and treat them as one of your
      assets.
The second method is to use one of the “dummy”
      currencies to track the RewardMiles. The dummy currencies are
      “XTS (Code for testing purposes)” and “XXX (No
      currency)”. If you use one of these for your
      LoyaltyGroupRewardMiles account, you can enter transactions into the
      account without having to enter share prices for every transaction.
      And, you can keep using the same two dummy currencies to track all
      sorts of amounts–vacation dollars earned and used so far this
      year, vacation hours earned and used, health insurance benefits
      allowance used and remaining, and so on. You can well imagine that
      GnuCash can be used as a hub for all sorts
      of personal metrics, in addition to finances.
The drawback here is that you cannot define exchange rates for
      the dummy currencies to convert them to ISO
      currencies. If you want to do that, you really should use the first
      method.


Putting It All Together



In the previous sections of this chapter the concepts and mechanics
    of working with transactions in GnuCash have been discussed. This section
    will expand upon the chart of accounts initially built in the previous
    chapter, by setting some opening balances, adding transactions and a
    scheduled transaction.
Open GnuCash file



Start with opening the previous datafile we stored,
      gcashdata_3emptyAccts, and store it as
      gcashdata_4 directly. The main window should look
      something like this:
[image: Starting point for Putting It All Together]This image shows the starting point for this
          section.




Opening Balances



As shown earlier with the Assets:Checking
      account, the starting balances in an account are typically assigned to a
      special account called Equity:Opening Balance. To
      start filling in this chart of account, begin by setting the starting
      balances for the accounts. Assume that there is $1000 in the savings
      account and $500 charged on the credit card.
	Open the Assets:Savings account register.
          Select View from the menu and check to make sure
          you are in Basic Ledger style. You will view your transactions in
          the other modes later, but for now let’s enter a basic transaction
          using the basic default style.

	From the Assets:Savings account register
          window, enter a basic 2 account transaction to set your starting
          balance to $1000, transferred from Equity:Opening Balance.
          Remember, basic transactions transfer money from
          a source account to a destination account. Record the transaction
          (press the Enter key, or click on 
          the Enter icon).

	From the Assets:Checking account register
          window, enter a basic 2 account transaction to set your starting
          balance to $1000, transferred from Equity:Opening Balance.

	From the Liabilities:Visa account
          register window, enter a basic 2 account transaction to set your
          starting balance to $500, transferred from Equity:Opening Balance.
          This is done by entering the $500 as a charge
          in the Visa account (or decrease in the Opening Balance account),
          since it is money you borrowed. Record the transaction (press the 
          Enter key, or click on 
          the Enter icon).



You should now have 3 accounts with opening balances set.
      Assets:Checking,
      Assets:Savings, and
      Liabilities:Visa.
[image: Chart accounts after setting opening balance]This image shows the opening
          balances.




Additional Transaction Examples



Now add some more transactions to simulate a month’s expenses.
      During the month, $78 is spent on electricity, $45 on phone, and $350 on
      rent. All paid by check. We also spent $45.21 on groceries, received $670
      as salary, and paid our Internet bill this month. Finally, let’s move
      $100 from the savings account to the checking account.
	Open the Expenses:Electricity account
          register and enter a simple 2 account transaction to pay the $78
          electrical bill at the end of the current month (eg: March 28,
          2006). Enter a description (eg: Light Company) and the check number
          (eg: 102). The Transfer account should be
          Assets:Checking.

	Open the Assets:Checking account register
          and enter a simple 2 account transaction to pay the $45 phone bill
          at the end of the current month (eg: March 28, 2006). Enter a
          description (eg: Phone Company Name) and the check number (eg: 103).
          The Transfer account should be
          Expenses:Phone. Notice that you can enter
          expense transactions from either the credit side (the expense
          accounts) or the debit side (the asset account).

	Open the Expenses:Rent account register
          and enter a simple 2 account transaction to pay the $350 in rent at
          the end of the current month (eg: March 28, 2006). Enter a
          description (eg: April Rent) and the check number (eg: 104). The
          Transfer account should be
          Assets:Checking.

	Duplicate this transaction using the
          Duplicate button in the Toolbar. Start by
          clicking on the current rent transaction, and click on the
          Duplicate icon. Enter the transaction date a
          month out in the future (eg: April 28, 2006), and notice the blue
          line separator that GnuCash uses to separate future transactions
          from current ones. In this way, you can enter transactions before
          they occur.
You could also set up a scheduled transaction to pay your
          rent, since the value of the rent is likely to be constant for the
          foreseeable future. 
	Start by clicking on the current (April 28) rent
                transaction, and click on the Schedule
                icon

	Change to Monthly, change
                description if needed and press OK




	To transfer money from your savings account to your checking
          account, open the Assets:Savings account
          register, add a new transaction setting
          the Transfer to Assets:Checking in the amount
          of $100 (date 6 March, 2006).

	As another example of a simple 2 account transaction, add
          another transaction to describe the purchase of $45.21 worth of
          groceries on 5 of March. From within the Assets:Checking account, you
          would set Transfer to
          Expenses:Groceries. The account register should
          now appear:

	To add a paycheck transaction from the
          Assets:Checking account register window, click
          on a new transaction line, and click on Split.
          First enter the description of this transaction on the first line
          (eg: “Employers R Us”), as well as the date (14 March). In the
          “split” line below this, enter the deposit into
          Assets:Checking (eg:$670). Follow this with the various tax deposits
          (Assets:Checking (eg: $670),
          Expenses:Taxes:Federal account (eg: $180),
          Expenses:Taxes:Medicare account (eg: $90), and
          Expenses:Taxes:Social Security account (eg: $60)) and
          lastly the gross total of your paycheck (eg: $1000) as a withdrawal
          transfer from Income:Salary.

	You also need to pay for your Internet subscription of 20 USD on
          the 28th.



[image: Chart accounts after setting all the various transactions]This image shows the ending balances after Chapter 4, Transactions.




Save file



Before we go to the report section, let’s save the GnuCash data
      file (gcashdata_4).

Reports



But only having data available on the computer screen will not
      make your accountant happy, therefore GnuCash comes with a large number
      of highly customizable reports.
Let’s have a look at a Cash Flow, and a
      Transaction Report.
	First let’s have a look at the Cash Flow
          report for the month of March.
Select the cash flow report from Reports → Income & Expense → Cash Flow.
[image: Cash Flow report for the month of March]This image shows the Cash Flow report after Chapter 4, Transactions.



To get this customized report, right click in the report and
          choose Report Options. Then set the time
          period, and specify which accounts you want in the report.

	Now let’s have a look at corresponding transaction report for
          the Checking account.
Select the transaction report from Reports → Transaction Report.
[image: Transaction Report for the Checking account during March]This image shows the Transaction Report for the
              Checking account during March. 




	Now let’s change the transaction report to only show the
          various Expenses accounts.
[image: Transaction Report for the Expenses accounts during March]This image shows the Transaction Report for the
              various Expense accounts during March. 








Appendix A. Migration Guide




This appendix is to help current users of other financial software packages in their migration to GnuCash.  We address the conceptual differences between the layout of GnuCash accounts versus other software packages.
  
Using Accounts vs. Categories




If you are familiar with other personal finance programs, you are already accustomed to tracking your income and expenses as categories. Since GnuCash is a double-entry system (refer to section 2.1), incomes and expenses are tracked in accounts. The basic concept is the same, but the account structure allows more consistency with accepted business practices. So, if you are a business user as well as a home user, GnuCash makes it easy to keep track of your business as well as your personal accounts.


Income and expense accounts give you the same information you would get with categories, but they also give you more flexibility in entering your transactions.    In GnuCash, you have the option to enter transactions directly into income and expense accounts through their account registers.   Other programs that use categories do not offer this option, because there is no “account register” for a category.


You also have the option in GnuCash to treat income and expense accounts exactly as you would treat categories, if you are more comfortable with that method.  In Quicken® and similar programs,  transactions require an account and a category.   Substitute an income or expense account name in GnuCash where you would normally enter a category name in the other programs, and the result should be the same.   We will discuss transaction entry in Chapter 4 in greater detail.



Putting It All Together



Note
This section begins a tutorial that will continue throughout this
      book. At the end of each chapter, you will see a Putting It
      All Together section that walks you through examples to
      illustrate concepts discussed in that section. Each Putting It
      All Together section builds on the previous one, so be sure
      to save your file for easy access.

Let’s get started!
	First, let’s create a file to store your real data. Open GnuCash
        and select File → New File
        from the Menubar. This will start the New Account Hierarchy Setup assistant that allows
        you to create several accounts at once.
Note
If you are running GnuCash for the first time, you will be presented with the
          Cannot find default values screen which is described in details in the 
          GnuCash manual.

[image: The New Account Hierarchy Setup assistant]This image shows the first screen of the New
            Account Hierarchy Setup assistant.



The first screen of the assistant gives you a description of what the assistant does.
      Click the Forward button to proceed to the next screen.

	In the second screen, select the currency to use for the new accounts from the dropdown list.
      Then press the Forward button.
Note
The currency you select here, will be assigned to all the
        accounts created in this assistant.

[image: The New Account Hierarchy Setup assistant - Currency]This image shows the second screen of the New
            Account Hierarchy Setup assistant where you select the
            currency.




	In the third screen select the Common Accounts group in the 
      Categories pane. Then press the Forward button to
      proceed.
Note
If you want, you can select one or more of the predefined account-groups here. For more
        information on account types, see the section called “GnuCash Accounts”.

[image: The New Account Hierarchy Setup assistant - Choose accounts]This image shows the third screen of the New
            Account Hierarchy Setup assistant where you choose the
            various accounts.




	In the fourth screen you will be able to set an Opening
      Balance on each of the accounts, as well as indicate if
      the account should be a Placeholder. As these features will be 
      described in next chapters, leave all as configured by GnuCash 
      and click Forward to open the last screen of the assistant.
[image: The New Account Hierarchy Setup assistant - Configure]This image shows the fourth screen of the New
            Account Hierarchy Setup assistant where you can set
            Opening Balance.




	In the last screen of the assistant, click Apply to create all the accounts and
      leave the assistant.
[image: The New Account Hierarchy Setup assistant - Finish]This image shows the last screen of the New
            Account Hierarchy Setup assistant.




	Your main window should now look something like this:
[image: The Main window showing the test file]

Next, create a file to store test data. This is the file that
        will be used in the tutorials throughout this manual. Click
        File → Save As... (or press 
        Shift+Ctrl+S on your keyboard)
        to open the Save As... dialog. Select XML as data
        format, name the file gcashdata_1 and select the folder where 
        the file will be saved.




Vendors



A vendor is a company or person from whom you purchase goods or services.  Vendors must be registered within the A/P system.
New



To register a new vendor, select the Business → Vendor → New Vendor menu item.  Fill in general information about the vendor, such as Company Name, Address, Phone, Fax, etc.  Below is a list of the other options: 
	Identification - Vendor Number - can be any number by which you would like to refer to this vendor.  You may leave it blank and a number will be chosen automatically.

	Identification - Active - differentiates active vendors from inactive ones. This is useful when you have many past vendors, and you want to see only those marked active

	Payment Address - Name - is the contact name of the person to receive payments you make.

	Notes - records any additional comments about the vendor.  Use it to track names of contact people within the vendor’s company, for example.

	Payment Information - Currency - specifies the default payment currency.

	Payment Information - Terms - specifies the default payment terms for this vendor.  Payment terms must be preregistered using Business → Billing Terms.

	Payment Information - Tax Included - specifies if tax is included in bills from this vendor.  You can choose Yes, No, or Use Global.
          
	Yes means that tax is already
                included in amounts on bills.

	No means tax is not included.

	Use Global means to use the setting
                made in the global preferences accessible through
                Edit → Preferences
                (Gnucash → Preferences on Mac OS X).




	Payment Information - Tax Table - specifies a default tax table to apply to bills from this vendor.  Tax tables must be registered using the Business → Tax Table menu item.



This is what the New Vendor registration window looks like:
[image: New Vendor Registration Window]New Vendor Registration Window
	       




Find and Edit



To search for an existing vendor, use the Business → Vendor → Find Vendor window.  You select a vendor to View/Edit from the results of the search.  This window is also used to look up a vendor when entering bills and processing payments.
[image: Find Vendor Window]Find Vendor Window
	       



If many vendors match the search criteria you provide, the
      search can be refined by running an additional search within the current
      results. The current result set is searched when the Refine
      Current Search radio button is selected. In fact, GnuCash
      selects this option for you after you run the initial search.
If the vendor you are searching for does not match the supplied
      search criteria, change the search criteria, click the New
      Search radio button and then the Find
      button. The relevant step is the New Search
      selection. If the vendor is not in the result of the original search,
      and you only search within this set, the vendor cannot be found,
      regardless of new search criteria.
Note
To return a list of all registered active vendors, set the search criterion to matches regex, and place a single dot “.” in the text field area.  Make sure Search only active data is checked, then click Find.  The regular expression “.” means to match anything.



Putting It All Together



Let’s go through the process of building a common personal finance
    chart of accounts using the information we have
    learned from this chapter. A chart of accounts is simply a new GnuCash
    file in which you group your accounts to track your finances. In building
    this chart of accounts, the first task is to divide the items you want to
    track into the basic account types of accounting. This is fairly simple,
    let’s go through an example.
Simple Example



Let us assume you have a checking and a savings account at a bank,
      and are employed and thus receive a paycheck. You have a credit card
      (Visa), and you pay monthly utilities in the form of rent, phone, and
      electricity. Naturally, you also need to buy groceries. For now, we will
      not worry about how much money you have in the bank, how much you owe on
      the credit card, etc. We want to simply build the framework for this
      chart of accounts.
Your assets would be the bank savings and
      checking account. Your liabilities are the credit
      card. Your Equity would be the starting values of
      your bank accounts and credit card (we do not have those amounts yet,
      but we know they exist). You have income in the
      form of a salary, and expenses in the form of
      groceries, rent, electricity, phone, and taxes (Federal, Social
      Security, Medicare) on your salary.

The Basic Top Level Accounts



Now, you must decide how you want to group these accounts. Most
      likely, you want your Assets grouped together, your Liabilities grouped
      together, your Equity grouped together, your Income grouped together,
      and your Expenses grouped together. This is the most common way of
      building a GnuCash chart of accounts, and it is highly recommended that
      you always begin this way.
Start with a clean GnuCash file by selecting 
      File → New File from the menu. The 
      New Account Hierarchy Setup assistant will start. Press Cancel to close 
      the assistant as we don’t want to use one of the predefined accounts structure; instead we will build a basic
      starting account structure from scratch. In the empty GnuCash window select 
      View → New Accounts Page from the menu: 
      the Accounts tab will open. Finally select 
      Actions → New Account....
Now you are ready to build this basic starting account structure
	Account name Assets (account type
          Asset, parent account New top level
          account)
[image: Creating an Assets account]This image shows the dialog to create an assets
                  account




	Account name Liabilities (account type
          Liability, parent account New top
          level account)

	Account name Equity (account type
          Equity, parent account New top level
          account)

	Account name Income (account type
          Income, parent account New top level
          account)

	Account name Expenses (account type
          Expenses, parent account New top
          level account)



When you have created the top-level accounts, the main Account page
      in GnuCash should look like below.
[image: The Basic Top-level Accounts]This image shows the basic top-level accounts.




Making Sub-Accounts



You can now add to this basic top-level tree structure by inserting
      some real transaction-holding sub-accounts. Notice that the tax accounts
      are placed within a sub-account named Taxes. You can make sub-accounts
      within sub-accounts. This is typically done with a group of related
      accounts (such as tax accounts in this example).
Tip
Instead of selecting Actions → New Account...
        from the menu, you can alternatively create a new sub-account of an account by right clicking
        on the main account’s name and selecting the New Account... entry. 
        This will open a dialog similar to the one depicted in
        the section called “The Basic Top Level Accounts” where the new sub-account will be already set as a 
        child of the main account.

	Account name Checking (account type
            Bank, parent account
            Assets)

	Account name Savings (account type
            Bank, parent account
            Assets)

	Account name Visa (account type
            Credit Card, parent account
            Liabilities)

	Account name Salary (account type
            Income, parent account
            Income)

	Account name Phone (account type
            Expense, parent account
            Expenses)

	Account name Electricity (account type
            Expense, parent account
            Expenses)

	Account name Rent (account type
            Expense, parent account
            Expenses)

	Account name Groceries (account type
            Expense, parent account
            Expenses)

	Account name Taxes (account type
            Expense, parent account
            Expenses)

	Account name Federal (account type
            Expense, parent account
            Expenses:Taxes)

	Account name Social Security (account
            type Expense, parent account
            Expenses:Taxes)

	Account name Medicare (account type
            Expense, parent account
            Expenses:Taxes)

	Account name Opening Balance (account
            type Equity, parent account
            Equity)



After you have created these additional sub-accounts, the end
      result should look like below
[image: The Basic Chart of Accounts]This image shows a simple chart of accounts.



Save this chart of accounts with the name
      gcashdata_3, as well as gcashdata_3emptyAccts,
      as we will continue to use them in the later chapters.
You have now created a chart of accounts to track a simple
      household budget. With this basic framework in place, we can now begin
      to populate the accounts with transactions. The next chapter will cover
      this subject in greater detail.


Setup Investment Portfolio



Now that you have built an account hierarchy in the previous
    section, this section will show you how to create and populate the accounts with your
    investment portfolio. After this initial setup of your portfolio, you may have
    shares of stock purchased from before you started using GnuCash. For these stocks,
    follow the instructions in the Entering
    Preexisting Shares section below. If your have just purchased your stocks,
    then use the Buying New Shares
     section.
Setup Accounts for Stocks and Mutual Funds



This section will show you how to add stocks and mutual fund
      accounts to GnuCash. In this section, we will assume you are using the
      basic account setup introduced in the previous section, but
      the principles can be applied to any account hierarchy.
You should have within the top level Asset
      account, a few levels down, an account entitled
      Stock. Open the account tree to this level by
      clicking on the “right facing triangle marker” signs next
      to the account names until the tree is opened to the depth of the new
      account. You will need to create a sub-account (of type
      stock) under the Stock account for every stock you
      own. Every stock is a separate account. The naming of these stock
      accounts is usually done using the stock ticker abbreviation, though account
      names may be anything that is clear to you and other users. So, for
      example, you could name your accounts AMZN,
      IBM and NST for your Amazon,
      IBM and NSTAR stocks respectively. Below is a schematic model of the
      layout (only showing the Assets sub-accounts).


 Assets

    Investments

       Brokerage Accounts

          Bond

          Mutual Funds

          Market Index

          Stock

             AMZN

             IBM

             NST

 

Note
If you want to track income (dividends/interest/capital gains)
        on a per-stock or fund basis, you will need to create an
        Income:Dividends:STOCKSYMBOL,
        Income:Cap Gain (Long):STOCKSYMBOL,
        Income:Cap Gain (Short):STOCKSYMBOL
        and Income:Interest:STOCKSYMBOL
        account for each stock you own that pays dividends or interest.


Example Stock Account



As an example, let’s assume that you currently own 100 shares of
      Amazon stock. First, create the stock account AMZN by selecting the
      Stock account and click on the menu Actions+New Account.... The New
      Account dialog will appear, follow the steps, in the sequence below to
      setup your new stock account.
[image: New Account Window]New Account Window 



	Account Name - Usually, use the stock
          ticker abbreviation, IE: “AMZN”

	Account Code - Optional field, use CUSIP,
          the newspaper listing symbol, mutual fund family ID or code of your
          own choosing.

	Description - Optional field for detailed
          description of the commodity/stock. Note this field by default is
          displayed in the Account tab tree.

	Account Type - Select the type of account
          you are creating from the lower left-hand list.

	Parent Account - Select the parent
          account for the new account from the right hand listing. Expand list
          of accounts if necessary.

	Create the New Security - To use a new
          stock, you must create the stock as a new commodity
	Select Security/Currency - Click on
              the Select ... button next to the
              security/currency line. We must change the
              security from the default (your default currency) to this
              specific stock. This will bring up the 
              Select Security dialog.

	Type - Change the
              type from current to the exchange where the
              security/commodity is traded (in this example NASDAQ).
Select the New button to open the
              New Security window.
[image: Select Security Window]Select Security Window 




	Create the Security - Click on the
              New... button and enter the appropriate
              information for this stock on the new form New Security.
	The Full name: is
                  “Amazon.com Inc”.

	The Symbol/abbreviation: is
                  “AMZN”.  The symbol is the stock ticket used in your
                  quote source several lines down on the form.  Note that different
                  symbols will be utilized on different price sources for the same stock,
                  an example is Ericsson on the Stockholm Exchange is ERIC-B while
                  on Yahoo it is ERRICB.ST

	The Type: should already be
                  “NASDAQ”.

	The CUSIP or other code is where
                  you can enter some other coding number or text (leave it
                  blank in this example).

	The Fraction traded should be
                  adjusted to the smallest fraction of this security which can
                  be traded, usually 1/100 or 1/10000.

	The box “Get On-line Quotes” and the
                  quote source and the timezone should be selected to define
                  the sources for updating prices on-line. See Also
                  
                    “Setting Stock Price Automatically”.
 If the Get On-Line Quotes button is not highlighted, and it
                  is not tickable, then the Finance::Quote package is not installed.
                  See the section on
                   
                    “Installing Finance::Quote”.
Below is what this window should look like when
                  finished: 
[image: New Security Window]New Security Window 




	Save Security - Click on the
                  OK button to save this new security,
                  this will close the New Security window and
                  return to the New Account window.







	Select the Security - you should now see
          the newly created security available in the pull down menu for
          Security/Currency. Select it (it is probably
          already selected) and click on OK.

	Smallest Fraction - Specify the smallest
          fraction of the security/commodity that is traded.

	Notes - Enter any notes or messages
          related to this security/commodity.

	Tax Related - Go to Edit → Tax Report Options to check this box if this 
          account’s transactions will relate to Income Taxes.

	Placeholder - Check box if this account
          is a “Placeholder”, that is it will contain no
          transactions.

	Finished - You should now have been
          automatically returned to the New Account dialog, with the
          symbol/abbreviation: line set to “AMZN
          (Amazon.com Inc)”. Click on OK to save
          this new stock account.



You have now created the Amazon stock account, your main account
      should look something like this (notice that there are a few extra
      accounts here, a bank account, and an equity account):
[image: Setup Current Portfolio]This image is after the creation of the first stock
          account (AMZN)



Open the account register window for this AMZN stock account
      (double click on it). Here you see the Commodity view. This gives you an overview of
      the transactions in this commodity including the number of units (shares for a stock or mutual fund) bought or sold, the net price per unit, and the total amount.
      Obviously, we have not bought or sold any shares of AMZN yet, so the register should not contain any transactions.


Chapter 1. Overview



Introduction



GnuCash is the personal finance software package made for you. It is
    versatile enough to keep track of all your financial information, from the
    simple to the very complex. It is one of the few financial software
    packages that supports global currencies, and it is the only open-source
    program of its kind. Best of all, GnuCash is easy to learn and use!
So, what can GnuCash do for you? It can keep track of your personal
    finances in as much detail as you prefer. If you are just starting out,
    use GnuCash to keep track of your checkbook. You may then decide to track
    cash as well as credit card purchases to better determine where your money
    is being spent. When you start investing, you can use GnuCash to help
    monitor your portfolio. Buying a vehicle or a home? GnuCash will help you
    plan the investment and track loan payments. If your financial records
    span the globe, GnuCash provides all the multiple-currency support you
    need.
[image: GnuCash Chart of Accounts - Teaser]This image shows a Chart of Accounts with multiple currencies and investments.



While GnuCash is well suited for personal finances, it is also
    powerful enough for business use. There are many business features, from
    integrated accounts receivable and payable systems, to tax table
    construction. You will find these and the many other business features
    surprisingly powerful and easy to use.


Setting Share Price



The value of a commodity, such as a stock, must be explicitly set.
    The stock accounts track the quantity of stocks you own, but the value of
    the stock is stored in the Price Editor. The values
    set in the Price Editor can be updated manually or automatically.
Initial Price Editor Setup



To use the Price Editor to track a stock value, you must initially
      insert the stock. To do so, open the Price Editor
      (Tools → Price Editor) and
      click on Add button. The first time a
      Commodity/Stock is entered this window will be blank except for the
      control buttons on the bottom. Select the appropriate Commodity you want
      to insert into the Price Editor. At this point, you can input the price
      of the commodity manually. There are 5 fields in the New Commodity
      window:
	Commodity - the name of the commodity,
          must be chosen from the Select... list

	Currency - the currency in which the
          Price is expressed.

	Date - date that the price is
          valid

	Type - one of: Bid
          (the market buying price), Ask (the market
          selling price), Last (the last transaction
          price), Net Asset Value (mutual fund price per
          share), or Unknown. Stocks and currencies will
          usually give their quotes as one of bid, ask or last. Mutual funds
          are often given as net asset value. For other commodities, simply
          choose Unknown. This option is for informational purposes only, it
          is not used by GnuCash.

	Price - the price of one unit of this
          commodity.



As an example of adding the AMZN commodity to the price editor,
      with an initial value of $40.50 per share.
[image: Price Editor]Adding the AMZN commodity to the price editor, with
          an initial value of $40.50 per share.



Click OK when finished. Once you have
      performed this initial placement of the commodity into the Price Editor,
      you will not have to do it again, even if you use the same commodity in
      another account.
Note
If you have online retrieval of quotes activated (see the section called “Configuring for Automatic Retrieval of Quotes”), you can initialize a
        commodity without manually making an entry. When you initially add
        the security in the Security Editor, check
        Get Online Quotes and save the security.
        Then, in the Price Editor, click
        Get Quotes, and the new security will be
        inserted into the price list with the retrieved price.


Setting Stock Price Manually



If the value of the commodity (stock) changes, you can adjust the
      value by entering the Price Editor, selecting the commodity, clicking on
      edit and entering the new price.
[image: Price Editor]The main price editor window, showing the list of all
          known commodities.




Configuring for Automatic Retrieval of Quotes



If you have more than a couple of commodities, you will tire of
      having to update their prices constantly. GnuCash has the ability to
      automatically download the most recent price for your commodities using
      the Internet. This is accomplished through the Perl module
      Finance::Quote, which must be installed in order to activate this
      feature.
To determine if the Perl module Finance::Quote is already
      installed on your system, type perldoc Finance::Quote in
      a terminal window and check to see if there is any documentation
      available. If you see the documentation, then the module is installed,
      if you do not see the documentation, then it has not been
      installed.
Installing Finance::Quote



Microsoft Windows:
	
	Close GnuCash.

	You need to have installed ActivePerl
            

	Run Install Online Price
	    Retrieval in the GnuCash
	    “Start” menu entry.




        
Mac OS X: You need to
	have XCode installed. XCode is an optional item from your OS X
	distribution DVD. Run the Update
	Finance Quote app in the
	GnuCash dmg. You can run it from the
	dmg or copy it to the same folder to which you copied
	GnuCash. It will open a Terminal
	window and run a script for you which will ask lots of
	questions. Accept the default for each unless you know what
	you’re doing.
Linux: 
	
	Close any running GnuCash instances.

	Locate the folder where GnuCash 
            is installed by searching for gnc-fq-update

	Change to that directory, open a root shell

	Run the command gnc-fq-update





	This will launch a Perl CPAN update session that will go out
	onto the internet and install the Finance::Quote module on
	your system. The gnc-fq-update program is interactive,
	however, with most systems you should be able to answer
	“no” to the first question: “Are you ready
	for manual configuration? [yes]” and the update will
	continue automatically from that point.
After installation is complete, you should run the “gnc-fq-dump”
        test program, in the same directory, distributed with GnuCash to test
        if Finance::Quote is installed and working properly.
Note
If you feel uncomfortable about performing any of these steps,
          please either email the GnuCash-user mailing list
          (<gnucash-user@gnucash.org>) for help or come to the GnuCash IRC
          channel on irc.gnome.org. You can also leave out this step and
          manually update your stock prices.


Configuring Securities for Online Quotes



With Finance::Quote installed and functioning correctly, you
        must configure your GnuCash securities to use this feature to
        obtain updated price information automatically. Whether creating new securities or modifying securities
        that have already been setup, use the Tools → Security Editor, to edit the
        security and check the Get Online Quotes box. You will
        now be able to modify the radio buttons for Type of quote source, the pull-down menus 
        to specify the specific source(s) and The timezone for these
        quotes. When finished editing, Close the Security Editor to return to
        the Price Editor and click on the Get Quotes
        button to update your stock prices on the Internet.
The command gnucash --add-price-quotes $HOME/gnucash-filename
        can be used to fetch the current prices of your stocks.  The file specified
        $HOME/gnucash-filename will depend on the name and location of your
        data file.
        This can be determined by the name displayed in the top frame of the GnuCash window,
        before the “-”.  The file name can also be found under File
        in the recently opened file list; the first item, numbered 1, is the name of the currently
        open file.
This can be automated by creating a crontab entry. For example,
        to update your file every Friday evening (16:00) after the relevant exchange
        markets close (modify the time accordingly for your time zone), you could add
        the following to your personal crontab:
0 16 * * 5 gnucash --add-price-quotes $HOME/gnucash-filename >
        /dev/null 2>&1
Remember that Mutual Fund “prices” are really “Net Asset
        Value” and require several hours after the exchange closes before being
        available. If NAVs are downloaded before the current days NAVs are
        determined, yesterday’s NAVs are retrieved.


Displaying Share Value



The main account window, by default, only shows the quantity of
      each commodity that you own, under the column heading
      Total. In the case of stocks, this commodity is the
      number of shares. Often, however, you will want to see the value of your
      stocks expressed in terms of some monetary unit. This is easily
      accomplished by entering the main window, selecting the Accounts tab,
      by clicking on the Titlebar Options button (the small
      down pointing arrow on the right side of the main account window titles bar), and
      selecting the option to display the account total field “Total
      (USD)”. You will see a new column in the main window entitled
      Total (USD) that will express the value of all
      commodities in the report currency.
[image: Viewing Stock Value]Viewing the value of a stock commodity in the main
          window using the Total in Report Currency option.




Selecting “Price Source” in Stock Value Reports



Most GnuCash Asset reports have options to set/modify a number of parameters for the report.  The
       Options windows is displayed by selecting the report tab then clicking on either the Options
       icon in the Menubar or selecting Edit → Report Options.  
       The General tab in the
       resulting window contains various parameters for the report.  One of these is “Price Source” which of offers
       three alternatives to determine stock prices in reports:
Note
In the example below, the report is a customization of
         the Average Balance report
         in the Assets & Liabilities reports submenu.

[image: Determining Stock Price Source in Reports]Determining the value of a stock commodity in a
          report by setting the Price Source option.



	Weighted Average - gives you a graph of
          the weighted price of all transactions. It will
          not take into account prices defined in the
          price editor.

	Most recent - displays the changing value
          of your stocks based solely on the most recent
          price available from the price editor. The price figuring in your
          stock transactions is not considered.

	Nearest in time - the graph is
          exclusively based on the prices available from the price editor. The
          value of your stock at each step and point in time is calculated
          based on the nearest available price in the price editor.



[image: An Asset Barchart Report based on the Nearest in time Price Source.]Tracking what value your stocks would’ve had on the
          stock exchanges.





Interest Bearing Accounts



Investments which have a fixed or variable rate of interest are one
    of the simplest and most common form of investments available. Interest
    bearing investments include your bank account, a certificate of deposit,
    or any other kind of investment in which you receive interest from the
    principal. This section will describe how to handle these kinds of
    investments in GnuCash.
Account Setup



When you purchase the interest bearing investment, you must create
      an asset account to record the purchase of the investment, an income
      account to record earnings from interest, and an expense account to
      record bank charges. Below is an account layout example, in which you
      have an interest bearing savings account and a certificate of deposit at
      your bank.


Assets

   Bank ABC

      CD

      Savings

Expenses

   Bank ABC

      Charges

Income

   Bank ABC

      Interest

  

As usual, this account hierarchy is simply presented as an
      example, you should create your accounts in a form which best matches
      your actual situation.

Example



Now let’s populate these accounts with real numbers. Let’s assume
      that you start with $10000 in your bank account, which pays 1% interest
      and you buy a $5000 certificate of deposit with a 6 month maturity date
      and a 2% yield. Clearly, it is much better to keep your money in the CD
      than in the savings account. After the initial purchase, your accounts
      should look something like this:
[image: Setup Interest Investment]This is an image of the account register after the
          creation and investing in a CD investment. 



Now, during the course of the next 6 month, you receive monthly
      bank statements which describe the activity of your account. In our
      fictional example, we do nothing with the money at this bank, so the
      only activity is income from interest and bank charges. The monthly bank
      charges are $2. After 6 months, the register window for the CD should
      look like this:
[image: Setup Interest Investment]This is an image of the register of the CD account
          after 6 months. 



And this is the main GnuCash window:
[image: Setup Interest Investment]This a screen capture of the accounts after 6 months.
          



From the above image of the main GnuCash account window you see a
      nice summary of what happened to these investments over the 6 months.
      While the yield on the CD is double that of the savings account, the
      return on the CD was $50.21 versus $13.03 for the savings account, or
      almost 4 times more. Why? Because of the pesky $2 bank charges that hit
      the savings account (which counted for $12 over 6 months).
After this 6 month period, the CD has reached maturity which means
      you may sell it with no early withdrawal penalty. To do so, simply
      transfer the $5050.21 from the CD account into the savings
      account.


Reconciling Your Accounts



GnuCash makes reconciliation of your bank account with your monthly
    bank statement much easier. the section called “Reconciliation” 
    gives instructions on how to
    reconcile your transactions with the monthly bank statement. This is the
    main reconciliation task that should be done every month.
But what about all those other accounts you created? Should those be
    reconciled too? If you receive a statement for the account, then you
    should consider reconciling that account. Examples include the checking
    account statement, the savings account statement, and the credit card
    statement. Credit card statements and credit card transactions are covered
    in the Chapter 6, Credit Cards, so if you are interested in 
    tracking your credit cards in GnuCash, take a look at the instructions 
    provided there.
Income and expense accounts are usually not reconciled, because
    there is no statement to check them against. You also don’t need to
    reconcile cash accounts, for the same reason. With a cash account, though,
    you might want to adjust the balance every once in a while, so that your
    actual cash on hand matches the balance in your cash account. Adjusting
    balances is covered in the next section.

Basic Concepts



Accounts Receivable (or A/R) refers to products or services provided
    by your company for which payment has not yet been received. This is
    represented on the balance sheet as an asset, because the expectation is
    that you will receive payment soon.

Automobile Loan (How-To)



The Automobile Loan, or in common terms, Car Loan, is treated more
    or less exactly as the House loan. The only difference is different
    accounts, and different interest rates.
Basic Car Loan Account Structure



-Asset

    -Current Assets

        -Savings Account

    -Fixed Assets

        -Car

-Liability

   -Loans

       -Car Loan

-Expenses

   -Interest

       -Car Loan Interest

   -Car Loan Adm Fees

For more information, please check the section called “House Mortgage (How-To)”

Converting XML GnuCash File



The GnuCash XML data file can be transformed to almost any other data
format (e.g., QIF, CSV...) quite easily if one is familiar with XSLT. 
The GnuCash data file is well-formed XML, and it can therefore be run
through an XSLT parser with an associated stylesheet.  This allows one
to transform the file to just about any format that can be designed,
given a properly written stylesheet.
A few steps need to be followed.  The writing of a stylesheet is a task
for a different time, but if you can get one written, here’s what you
need to do:
	Copy the GnuCash to a working file.  Modify the working file’s
<gnc-v2> tag to read something like what’s below.  Note that you can
pretty much put anything you want in the “="..."” part; I used the URL
because it’s traditional (if such can be said about such a young
technology!).


<gnc-v2 xmlns:cd="http://www.gnucash.org/XML/cd"

        xmlns:book="http://www.gnucash.org/XML/book"

        xmlns:gnc="http://www.gnucash.org/XML/gnc"

        xmlns:cmdty="http://www.gnucash.org/XML/cmdty"

        xmlns:trn="http://www.gnucash.org/XML/trn"

        xmlns:split="http://www.gnucash.org/XML/split"

        xmlns:act="http://www.gnucash.org/XML/act"

        xmlns:price="http://www.gnucash.org/XML/price"

        xmlns:ts="http://www.gnucash.org/XML/ts"

        xmlns:slot="http://www.gnucash.org/XML/kvpslot"

        xmlns:cust="http://www.gnucash.org/XML/cust"

        xmlns:entry="http://www.gnucash.org/XML/entry"

        xmlns:lot="http://www.gnucash.org/XML/lot"

        xmlns:invoice="http://www.gnucash.org/XML/invoice"

        xmlns:owner="http://www.gnucash.org/XML/owner"

        xmlns:job="http://www.gnucash.org/XML/job"

        xmlns:billterm="http://www.gnucash.org/XML/billterm"

        xmlns:bt-days="http://www.gnucash.org/XML/bt-days"

        xmlns:sx="http://www.gnucash.org/XML/sx"

        xmlns:fs="http://www.gnucash.org/XML/fs"

        xmlns:addr="http://www.gnucash.org/XML/custaddr">

 


	Create an XSLT stylesheet containing the transformation your desire,
or obtain one that’s already written (AFAIK, there aren’t any, but I’m
working on a CSV one).

	Install an XSLT processor such as Saxon
(http://saxon.sourceforge.net/) or Xalan-J  (http://xml.apache.org/). 
Any conforming processor will do, really...

	Run the work file and the stylesheet through the processor according
to the processor’s instructions.

	You will now have a file in the desired output format.  An
enterprising individual could go so far as to write a stylesheet to
transform the GnuCash data file to an OpenOffice spreadsheet (or
vice-versa, for that matter).  Such things as QIF ought to be a little
less work.



Benefits are that you don’t need to write a Scheme module or a new C
routine to do this transformation.  Anyone who knows or can learn XML
and XSLT can perform this task.  Not much harder, really, than writing a
Web page....
Anyhow, I just wanted this tidbit to be captured somewhere permanently. 
The process works on 2.4.7 datafiles, and ought to
work on earlier versions, too.

Chapter 10. Multiple Currencies



This chapter will show you how to setup your GnuCash accounts to use
  multiple currencies.
Basic Concepts



GnuCash supports over a hundred currencies, from the Andorran Franc
    to the Zimbabwe Dollar. For example, you can have a bank account setup in Euros, and
    another using Hong Kong Dollars.
Some of the issues which arise when using multiple currencies are, how
    do you transfer funds between accounts with different currencies? How do
    you calculate the overall value when you have mixed currency accounts? How
    do reports deal with mixed currencies?
Note
An alternative way to manage multiple currency accounts from the one
      presented in the next sections, is to use the trading accounts 
      capabilities of GnuCash. This feature, which has been 
      introduced with GnuCash version 2.3.14, can be enabled by 
      going to the Accounts tab under File → 
      Properties.
For a complete guide on trading accounts
      you can take a look 
      at this tutorial by Peter Selinger.



